
  

 

 

Featured launch: New Google Docs features help 
power team collaboration 
Get on the same page with Google Docs 

● Track changes, make progress 
● Use new templates, add-on time-saving functionality 
● Find the information you need, when you need it 

 

 

 

 

Work together 
Recognized handwriting editing and more with the latest Jamboard release 
Making it easier to join meetings from third-party clients 
Jamboard now available for purchase in Canada 

 

 

 

Work anywhere 
Google’s Contacts app (v2.1) now available for more Android devices 

 

 

 

Simple to use 
Find content and communities from all across Google+ with the new Discover 
stream 

 

 

 

Business ready 
Easily create, delete, and rotate the X.509 certificates used with SAML apps 
Better manage large events in Google Calendar 
Data Loss Prevention now available in Team Drives 
Anti-phishing security checks in the Gmail app for iOS 
Map your site to a custom URL in the new Google Sites 
Managing Android Wear 2.0 devices with Google Mobile Management 

 

 
 

 

 

Learn more about G Suite  
Cloud Connect: The community for G Suite administrators 
What’s New for G Suite Admins videos 

 
To help you better track the full breadth of G Suite launches, including those that aren’t announced on the G 
Suite Updates blog, check out the What’s new in G Suite page in the Help Center. 
 
We’d really appreciate your thoughts on how we can make this resource work best for you. 

 
- The G Suite Team, Sept 5, 2017 

 

https://gsuiteupdates.googleblog.com/
https://gsuiteupdates.googleblog.com/
https://support.google.com/a/go/whatsnew
https://docs.google.com/a/google.com/forms/d/19AJmnJuG_JWdOTSf0B_kL1DFemE8bbkJbZ42Iz6uDx0/viewform


 

 

Featured launch: New Google Docs features 
help power team collaboration 

Get on the same page with Google Docs 

  Announced August 18th, 2017                                      Share with your organization                                     - back to top - 

What’s new: Getting people on the same page for a project can be tough. It requires managing a ton of 
opinions and suggestions. The last thing you should have to worry about is making sure your team is literally 
working on the same document. That’s why we built our powerful real-time editing tools to help with 
this—Google Docs, Sheets and Slides—so that teams can work together at the same time, using the most 
up-to-date version. 
 
With this launch, we introduced new updates to better help with "version control," to customize tools for your 
workflows, and to help teams locate information when they need it. 
 
Track changes, make progress 
 
It can take dozens of edits to make a document just right—especially a legal agreement, project proposal or 
research paper. These new updates in Docs let you more easily track your team’s changes. Now, your team 
can: 
 
1. Name versions of a Doc, Sheet or Slide on the web. 
Being able to assign custom names to versions of your document is a great way to keep a historical record of 
your team's progress. It's also helpful for communicating when a document is actually final. You can organize 
and track your team’s changes in one place under “Version history” (formerly known as “Revision history”) on 
the web. Select File > Version history > Name current version. For even quicker recall, there’s an option to 
select “Only show named versions” in Docs, Sheets or Slides. 
 
2. Preview “clean versions” of Docs on the web to see what your Doc looks like without comments or 
suggested edits. 
Select Tools > Review suggested edits > Preview accept all OR Preview reject all. 
 
3. Accept or reject all edit suggestions at once in your Doc so your team doesn’t have to review every single 
punctuation mark or formatting update. 
Select Tools > Review suggested edits > Accept all OR Reject all. 
 
4. Suggest changes in a Doc from an Android, iPhone or iPad device. 
Click the three dots menu in the top right of your Doc screen to suggest edits on the go. Turn on the “Suggest 
changes” toggle and start typing in “suggestion mode.” 
 
5. Compare documents and review redlines instantly with Litera Change-Pro or Workshare Add-ons in Docs.  
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https://www.workshare.com/blog/workshare-announces-new-comparison-capability-in-google-docs-and-drive
https://www.litera.com/announcing-gsuite-integration/
https://gsuite.google.com/products/docs/


 

 

 
Here’s a quick way to preview and accept all changes (or reject them) and name versions of your document. 

 
 
Use new templates, add-on time-saving functionality 
 
Teams use templates in Docs and Sheets to save time on formatting. At the same time, developers are 
building add-ons to customize functionality. We thought, why not bring these two together? That’s why we 
introduced new templates with built-in add-ons and the ability to create your own, so your templates not only 
look good—but they make sure the work gets done. 
 
These templates allow you to customize and deploy tools specific to your organization’s workflows. We’ve 
launched five examples of this in the general template gallery, like the new Mutual Non-Disclosure Agreement 
(NDA) template from LegalZoom and DocuSign. With this template, businesses can quickly create an NDA 
and collect signatures using the DocuSign Add-on for Docs. Bonus: it also automatically detects the required 
signature fields on the template, which saves even more time when you request signatures. This is just one of 
a few new templates—we’ve also worked with Lucidchart to create a business process manual, PandaDoc for 
a consulting agreement, Supermetrics for a website paid traffic report, and EasyBib for an MLA report. Each 
should help you save time and maximize efficiency throughout your team’s workflows. 
 
In addition, you can create your very own template with built-in add-on  customized to your company’s 
workflows. For example, create a Sheets template paired with an add-on to gather internal approvals or an 
invoice template in Docs (paired with an add-on) that pulls information from your CRM system. 
 
Admins, if you don’t currently allow your users to install add-ons, you can still use these new templates by 
deploying specific add-ons only. Or, if you’d prefer to allow your users to install only certain add-ons, you can 
block specific third-party OAuth scopes and whitelist only those add-ons you trust. 
 
Note that templates paired with add-ons abide by the same Admin console settings as all other templates and 
are available in English only. 
 

 
 

The new Mutual NDA template from LegalZoom and DocuSign lets you collect NDA approvals stat. 
 

 
Find the information you need, when you need it 
 
Sometimes the hardest part of creating a proposal or client presentation is tracking down the information you 
need to include in it. Now for G Suite Business and Enterprise customers, Google Cloud Search will integrate 
with Docs and Slides via the Explore feature. Using Machine Intelligence, Cloud Search surfaces relevant 
information to help you work more efficiently throughout your day. 
 
To get started, open the Explore tab in Docs or Slides and type what you’re looking for. Cloud Search will show 
you important details from your information across your G Suite apps including Gmail, Drive, Calendar, Sites 
and more, to help you create top-notch Docs and presentations. 
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https://developers.google.com/apps-script/add-ons/
https://support.google.com/a/answer/4530135
https://support.google.com/a/answer/7281227
https://support.google.com/a/answer/3055325
https://www.blog.google/products/g-suite/introducing-google-cloud-search-g-suite/
https://www.blog.google/products/g-suite/save-time-new-custom-templates-docs-sheets-slides-and-forms/
https://docs.google.com/document/u/0/?ftv=1&tgif=c
https://chrome.google.com/webstore/detail/docusign-%E2%80%93-electronic-sig/cijgknlennokkmmfbmhnjgldnnffokjk?hl=en
https://support.google.com/docs/answer/148833?co=GENIE.Platform%3DDesktop&oco=1


 
 

Now you can use Google Cloud Search through the Explore feature in Docs and Slides. 
 

 
Teams are using Docs to collaborate in creative ways. Check out this post for inspiration, or visit the Docs site 
to get started. 
 
More Information 

● Versions 
○ Help Center: See what’s changed in a file 

● Suggestions 
○ Help Center: Suggest edits in Google Docs 

● Templates 
○ Help Center: Create a file from a template 
○ Help Center: Enable add-ons in Google Docs editors 
○ Help Center: Whitelisting connected apps 
○ Help Center: Manage templates for Docs, Sheets, Slides, and Forms 

● Cloud Search in Explore 
○ Help Center: See and use suggested content in a document 
○ Help Center: See and use suggested layouts in a presentation 
○ Help Center: Turn Cloud Search on or off for users 

 

 
   

4 

https://docs.google.com/document/u/0/?tgif=d
https://support.google.com/docs/answer/7130307
https://support.google.com/a/answer/3055325
https://support.google.com/docs/answer/190843
https://support.google.com/a/answer/7281227
https://support.google.com/a/answer/4530135
https://www.blog.google/products/g-suite/five-new-ways-reach-your-goals-faster-g-suite/
https://support.google.com/docs/answer/2481802
https://support.google.com/a/answer/6167160
https://support.google.com/docs/answer/148833
https://support.google.com/docs/answer/6033474


 

Work together 
Recognized handwriting editing and more with the latest Jamboard release 

  Announced on August 9th, 2017                                      Share with your organization                                  - back to top - 

 
What’s new: More and more G Suite customers like Instrument are using Jamboard to generate and share 
creative ideas. The latest Jamboard release brings several new features―to both devices and the Jamboard 
app―to help people create and iterate on their ideas more quickly. We’re also making it easier for admins to 
monitor their Jamboard devices. 
 
Edit recognized handwriting 
People can now edit their recognized handwritten text with the stylus, allowing for the quick deletion, 
insertion, and merging of text. To delete, simply strike over the letter(s) you would like to remove from a word. 
To insert letter(s), write these either above or below the word and draw a small arrow to insert them. To 
merge, select a text object and drag it to another text object. 
 

 
Text Deletion  

 

 
Text Insertion 

 

 
Merging Text 

 
GIF support 
Jamboard now supports adding GIF images via Google Drive, so you can create rich, dynamic images as part 
of your jam session. 
 
Moving objects to adjacent jam frames 
By popular demand, objects can now be moved to adjacent jam frames/pages by selecting and sliding them 
towards the left or right edge of the screen. 
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https://www.blog.google/products/g-suite/save-thought-how-instrument-uses-jamboard-capture-and-share-ideas/


 

 
 
 
Additional reporting in the Jamboard Admin console 
Jamboard admins can now see historical data for Wi-Fi network strength (RSSI), Wi-Fi network speed, and 
board online/offline status in the Jamboard Admin console. 
 
For a full list of new features and improvements from this month’s release, check out the What’s New in 
Jamboard page in the Help Center. 
 

 

Making it easier to join meetings from third-party clients 

  Announced on August 10th, 2017                                      Share with your organization                                  - back to top - 

 
What’s new: With this launch, whenever someone uses a third-party CalDAV-based calendaring client to 
access an event on Google Calendar, we will add automatically generated text to the event’s description. This 
text will include instructions on how to join the event through Meet or Hangouts. 
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https://support.google.com/jamboard/answer/7384351#august8
https://support.google.com/jamboard/answer/7384351#august8


 

With this launch, people using the CalDAV API, such as those on Apple's calendar clients, no longer need to go 
to Google Calendar on the web to join their meetings. 
 

Jamboard now available for purchase in Canada 

  Announced on August 22nd, 2017      Admin feature                                    - back to top - 

 
What’s new: Back in May we announced that Jamboard, our cloud-based, collaborative whiteboard, was 
available for purchase in the United States. Now, we’re bringing Jamboard to Canada*, with more countries to 
follow. 
 
G Suite customers in Canada can now purchase Jamboard for $6,949 (CAD), which includes two styluses, an 
eraser, and a wall mount. We’re also running a promotion—if you order on or before December 31, 2017, you’ll 
receive a discount off of the annual management and support fee, as well as a discount on the optional rolling 
stand. See the table below for pricing and promotion details.  
 
Keep in mind that a G Suite license is required to use Jamboard so that you can access files from Drive, use 
them in your brainstorms and come back to your work later. 

 
Canada-based G Suite customers can contact their Google Cloud sales rep or fill out an interest form to learn 
more about how to start jamming with colleagues today. 
 
Additional info for G Suite admins 
In addition to the Jamboard device, the Jamboard app is available on Android and iOS for all G Suite 
customers. When used on a tablet, the Jamboard app allows users to experience similar features as they 
would on the Jamboard device. On a smartphone, the app functions as a companion for the Jamboard 
device. 
 
Usage of the Jamboard app is controlled by a service on/off switch in the Admin console, and is off by 
default. 
 
Check out the Help Center for more information, including an FAQ section. 
 
*Jamboard is coming to the following Canadian provinces: Alberta, British Columbia, Manitoba, New Brunswick, 
Newfoundland and Labrador, Nova Scotia, Ontario, Prince Edward Island, and Saskatchewan.  
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https://support.google.com/jamboard/answer/7393321
https://www.blog.google/products/g-suite/lets-jam-jamboard-now-available
https://support.google.com/jamboard
https://google.com/jamboard
https://gsuite.google.com/contact-form/jamboard/
https://support.google.com/jamboard/answer/7384240


 

Work anywhere 
Google’s Contacts app (v2.1) now available for more Android devices 

  Announced on August 23rd, 2017                                      Share with your organization                                  - back to top - 

 
What’s new: Google’s Contacts app is now available for any device running Android 5.0 
(Lollipop) or higher, including Samsung, LG, Motorola, and others. 
 
Android users in your organization can now download version 2.1 of the Contacts app 
from the Play Store. This version features: 
 

● A simple way to move contacts from a device’s storage into a Google Account, so the contacts are 
safely backed up and available on all devices. 

● Clear separation between work and personal contacts. 
● Suggestions for adding new contacts, cleaning up duplicates, and more. 

For more information on using the Contacts app on Android devices, check out the Help Center. 
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https://support.google.com/a/answer/2485666
https://play.google.com/store/apps/details?id=com.google.android.contacts


 

Simple to use  
Find content and communities from all across Google+ with the new Discover 
stream 

  Announced on August 16th, 2017      Share with your organization                                  - back to top - 

 
What’s new: To help people using Google+ find the most relevant and useful conversations happening inside 
their companies, we’ve introduced a new Discover tab on iOS devices and the web. 
 

 
 
Here they’ll find personalized recommendations of posts to see, people to know, and communities to join -- 
helping them stay in the loop on information being shared within your company. 
 
To make way for Discover, you may have noticed we removed the Collections tab. “Featured Collections” have 
a new home within Discover and “Your / Followed Collections” can be found by clicking on “Communities and 
Collections” on your profile. 
 
Based on user feedback, we’ve also simplified tab navigation. With the addition of the Profile tab on mobile, 
it’s easier for people to reach their profile pages, where they can then quickly access their communities and 
collections. With this launch, we aim to make it easy for people to focus on what they’re interested in.  
 
Check out the Help Center for more information. 
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https://support.google.com/plus#topic=6320382


 

 

Business ready 
Easily create, delete, and rotate the X.509 certificates used with SAML apps 

  Announced on August 2nd, 2017      Admin feature                                                    - back to top - 

 
What’s new: SAML uses X.509 certificates to ensure the authenticity and integrity of 
messages shared between an Identity Provider (IdP) and Service Provider (SP). These 
certificates are associated with your SAML applications when you first install them via 
the Admin console and have a five-year lifetime. When a certificate expires, a user can’t 
sign in to the associated application using SAML-based SSO. 
 
To change an application’s existing certificate (e.g. because it’s about to expire or has been compromised in 
some way), an admin needs to “rotate” it. Traditionally, you could do this with help from Google Support. With 
this launch, we’re giving you the ability to do so on your own in the Admin console, where you can easily view 
certificates in use, identify those about to expire, create new ones, and assign them to applications. 
 
Please note that only super admins will be able to view the expiration status of SAML certificates and take 
action on them. 
 
To learn more about SAML certificate rotation and how to manage certificates, please visit the Help Center.  
 
 

Better manage large events in Google Calendar 

  Announced on August 8th, 2017                                      Share with your organization                               - back to top - 

 
What’s new: Organizing an event with a lot of attendees can be complicated. It’s critical that you allocate the 
right space for the event, understand how many people will attend, and even check if some specific people, 
like executives or important clients, will be there. That’s why we’re making it easier to effectively manage 
events of any size in Google Calendar. 
 
With this launch, event organizers working on large events (200 or more guests) can: 
 

● Use Google Sheets to more easily see who is attending:  With this launch, organizers of large events 
can now use Calendar on the web to export guest lists to Google Sheets, and can also view the total 
number of attendees. 
 

● Invite large group mailing lists reliably: Previously, invites that included large group mailing lists 
wouldn’t update if membership in those groups changed. Going forward, if a group mailing list has 
been invited to a newly-created event, Calendar will automatically invite any new group members who 
join after the invite was sent and automatically remove members who leave. In addition, for existing, 
recurring large events, organizers who would like to make the event dynamic can do so via the steps 
outlined in this Help Center article. 
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https://support.google.com/a/answer/2405986
https://support.google.com/a/topic/6194927
https://support.google.com/a/answer/7394709
https://support.google.com/calendar/answer/172013
https://en.wikipedia.org/wiki/X.509


 

 
 
We hope these feature additions help your organization successfully host and manage events of any size. 
 
More Information 

● Help Center: Invite people to your Calendar event 
● Help Center: Invite groups to calendar events 

 
 

Data Loss Prevention now available in Team Drives 

  Announced on August 8th, 2017      Admin feature                                                    - back to top - 

 
What’s new: Protecting your company’s confidential data is critical, regardless of where it’s stored. In January 
of this year, we announced Data Loss Prevention (DLP) for Google Drive, giving G Suite Enterprise edition 
customers more control over how data is shared beyond their company. Now, we’re bringing DLP to content 
stored in Team Drives. 
 
DLP analyzes the files in your organization’s Team Drives for sensitive content. You can set up policy-based 
actions that will be triggered when any sensitive content is detected. G Suite admins will be able to control 
what content members of the team can share externally using easily configured rules and easily enforced 
policies. 
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https://support.google.com/calendar/answer/172013
https://support.google.com/a/answer/6321530
https://gsuiteupdates.googleblog.com/2017/01/g-suite-builds-momentum-with-enterprise.html
https://support.google.com/calendar/answer/37161


 

Important notes about Team Drives: 
 

● Because Team Drives are owned by the domain, rather than individuals, existing DLP rules applied at 
the domain level will apply to Team Drives. 

● If a DLP rule is assigned to an organizational unit or a group, then that rule will not apply to Team 
Drives. 

● When files stored in a Team Drive are flagged by DLP rules, users outside of your organization will lose 
access to these files. 

For detailed instructions on how to set up these rules and policies, visit the Help Center.  
 

Anti-phishing security checks in the Gmail app for iOS 

  Announced on August 10th, 2017                                      Share with your organization                                    - back to top - 

 
What’s new: In May of this year, we introduced anti-phishing security checks in the Gmail Android app. We’re 
now bringing similar checks to the Gmail app on your iOS device. Going forward, when you click on a 
suspicious link in a Gmail message on your iPhone or iPad, we’ll show the warning below. We recommend 
that you use caution before proceeding, because the link is likely unsafe. Only proceed if you’re confident 
there’s no risk. 

 
 
If you click on a link we know to be dangerous, we’ll show you a page like the one below and warn you against 
visiting the original URL. 
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https://support.google.com/a/answer/6321530
https://gsuiteupdates.googleblog.com/2017/05/making-email-safer-with-Gmail-click-time-security-checks.html


 

 
 
These warnings are intended to prevent harmful phishing attacks and help you keep your account safe.  
 
For more information about avoiding and reporting phishing emails, check out the Help Center. 
 
 

Map your site to a custom URL in the new Google Sites 

  Announced on August 21st, 2017      Admin feature                                                    - back to top - 

 
What’s new: As a professional organization, it’s often important that you host both internal and external info 
at a well-known URL. Already supported in the classic Google Sites, this is now available in the new Google 
Sites as well.  
 

 
Web address mapping settings in the Admin console 
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https://support.google.com/mail/answer/8253


 

 
Users in domains with web address mapping set up will see a similar message when publishing sites 

 
Important notes 

● For sites that are viewable within your organization only, the link is redirected to the Google Sites URL 
(such as http://sites.google.com/example.com/mysite). 

● New Sites address mappings automatically provision domain-validated SSL certificates for secure 
connections. You cannot use other certificates. 

● You may need to wait up to 24 hours to see your changes reflected. This feature is not available for 
trial domains. 

For more information on how to set up web address mapping in the Admin console, check out the Help Center. 
 
 

Managing Android Wear 2.0 devices with Google Mobile Management 

  Announced on August 28th, 2017      Admin feature                                                    - back to top - 

 
What’s new: When we launched Android Wear 2.0, we launched more than a platform for notifications on a 
watch—we launched an extension of your phone. With Android Wear 2.0, you can write emails, manage 
calendar appointments, chat with coworkers, make calls, and more. 
 
As a G Suite administrator, we believe that you should be able to manage any device—not just smartphones 
and tablets, but watches as well. That’s why we’ve made it possible to manage Android Wear 2.0 devices with 
Google Mobile Management. Now you can enforce policies (like requiring a PIN or a password) and remove 
corporate data if a user’s Android Wear 2.0 watch is lost or stolen. 
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https://support.google.com/a/answer/1734200
https://www.blog.google/products/android-wear/android-wear-20-make-most-every-minute/
https://support.google.com/a/answer/7392423


 
 
If you’re already managing devices with Google Mobile Management, there’s nothing more you need to do. If 
an employee adds her corporate account to a watch with Android Wear 2.0, she'll be automatically prompted 
to download the Google Apps Device Policy app and set up her watch accordingly. 
 
If you’re not managing devices with Google Mobile Management, we’ve now made it easier than ever.  
 
Check out our guide on the Help Center for steps to get started: 

● Help Center: Manage your business's mobile devices 
● Help Center: Set up mobile device management automatically 
● Help Center: Get G Suite apps on your Android Wear smartwatch 
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https://support.google.com/a/answer/7397527
https://support.google.com/a/users/answer/7334174
https://support.google.com/a/answer/1734200
https://support.google.com/a/users/answer/7334174


 

 

Learn more about G Suite 
Cloud Connect: The official community for G Suite Admins 

   Admin resource                                                                                                                                               - back to top - 

 
Sign in today: Cloud Connect is your one stop shop for 
resources to make your work with G Suite easier. Sign in 
today to discuss best practices, ask questions, and 
communicate with your peers and Googlers. Don’t miss 
out! Make sure you follow our Community Manager, 
Lauren Gallegos, to get the weekly buzz. 
 
What’s new: In August, we continued our Editorial 
Calendar for Q3. We added new use cases to our 
growing catalog, covering topics like Integration between 

G Suite and GCP and Transfer Appliance: Sneakernet for the Cloud Era. 

To top things off, Kim Wylie continued her blog series on Change Management with articles on The Power of 
Positivity in Work, Life and Change Projects and Getting employees involved in change projects to increase 
their sense of ownership and improve project success. Join us in September for more use cases on your 
favorite Google Cloud products.  

 

What’s New for G Suite Admins videos 

   Admin resource                                                                                                                                                            - back to top - 

 

 

What’s new: The What’s New for G Suite Admins videos 
provide a recap of all of the features we've released in the 
past month that are relevant to G Suite Admins, so you can 
watch and share them whenever you want. 
 

How it works: Bookmark the playlist on YouTube and check 
back each month for updates.  

 
Thanks for checking out our newsletter!  

We’d really appreciate your thoughts on how we can make this work best for you. 
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https://connect.googleforwork.com/docs/DOC-12597
https://docs.google.com/a/google.com/forms/d/19AJmnJuG_JWdOTSf0B_kL1DFemE8bbkJbZ42Iz6uDx0/viewform
https://connect.googleforwork.com/docs/DOC-20581
https://connect.googleforwork.com/docs/DOC-20443
http://www.youtube.com/playlist?list=PLU8ezI8GYqs4NSPPqm9hkdWPziVh_O3EC
https://connect.googleforwork.com/community/customers/?utm_source=WhatsNewJuly15Recap&utm_medium=referral&utm_campaign=JoinGWC
https://connect.googleforwork.com/people/sso-115902687250173948232
https://connect.googleforwork.com/community/customers/?utm_source=WhatsNewJuly15Recap&utm_medium=referral&utm_campaign=JoinGWC
https://connect.googleforwork.com/docs/DOC-20773
https://connect.googleforwork.com/docs/DOC-12597
https://connect.googleforwork.com/docs/DOC-20581
http://www.youtube.com/playlist?list=PLU8ezI8GYqs4NSPPqm9hkdWPziVh_O3EC
https://connect.googleforwork.com/people/sso-115902687250173948232
https://connect.googleforwork.com/docs/DOC-20443

